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Abstrakt

Tato práce se zabývá implementaćı podpory konstruováńı a předevš́ım správy podnikových
dat na pracovǐsti, které slouž́ı jako model skutečného podniku. Má za ćıl vychovat studenty
konstruktéry, kteř́ı jsou jednak schopni pracovat s 3D CAD systémem a také organizovat
všechny informace o výrobku tak, aby byly vždy a kdekoliv k dispozici.

Stávaj́ıćı pracovǐstě tak bude obohaceno o PDM systém Optegra a SmarTeam, ab-
solvent př́ıslušných kurz̊u přijde do praxe již připraven a ani př́ıpadný přechod na jiný
software, řeš́ıćı stejnou problematiku, by mu neměl činit pot́ıže.
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1.3 Model výuky CAD systémů na UETE . . . . . . . . . . . . . . . . . . . . 7
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3.7 Program Flow Chart Designer systému SmarTeam . . . . . . . . . . . . . . 34



Seznam tabulek
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Úvod

V dnešńı uspěchané době je jedńım z nejd̊uležitěǰśıch faktor̊u v konkurenčńım boji rychlost,
tedy čas. Přizp̊usobuje se všechno a ani konstruktéři se tomuto trendu neubráńı. Počátky
konstrukce jsou někde v ručńıch náčrtech tužkou na paṕır, vývoj postupoval přes kresĺıćı
prkno s trubičkovými pery, hitem uplynulého desetilet́ı byl AutoCAD. Svět se stále v́ıce
globalizuje a konkurenčńı tlak na trźıch roste, novým trend̊um se muśı přizp̊usobit i složky
technické př́ıpravy výroby. Je tedy třeba učinit daľśı krok a přej́ıt od 2D k 3D prostoru, od
explicitńıho kresleńı k parametrickému a od paṕırových šanon̊u se záznamy k digitálńım
archiv̊um.

Tato má práce je situována do prostřed́ı, kde tým odborńık̊u již několik let pracuje na
vytvořeńı simulace reálné konstrukčńı kanceláře. Použ́ıvaj́ı se zde nejrozš́ı̌reněǰśı CADy
jako AutoCAD s nadstavbami Mechanical Desktop a MechSoft PROFI. Dále se zde
pracuje s 3D parametrickým systémem CADDS5, který je zástupcem skupiny CAD/CAM
systémů na nejvyšš́ı úrovni. Právě s t́ımto systémem je spojena tato bakalářská práce.
Jej́ım úkolem nemá být zavedeńı daľśıho CADu, nýbrž implementace systému pro správu
informaćı o modelovaném výrobku. CADDS5 je komplexńı systém pro návrh výrobk̊u,
konstruktér potřebuje ke své práci kromě svých znalost́ı a tv̊urč́ıho myšleńı obvykle
také velké množstv́ı informaćı. Mým úkolem tedy je zavést na pracovǐstě systém, který
umožňuje okamžitě dodat aktuálńı a přesné informace. Samozřejmě to muśı být systém,
který dokáže jednak pracovat s r̊uznými druhy dokument̊u od dopisu sekretářky přes infor-
mace od dodavatel̊u až po 3D modely výrobku a také muśı být nezávislý na tom, ve které
kanceláři či budově se právě nacháźıte. K tomuto účelu byl vybrán PDM systém Opte-
gra, který je úzce spjat s CADDS5, nebot’ výrobcem obou systémů je firma Parametric
Technology Corp. a nejlépe poslouž́ı pro naše demonstračńı účely.

Svou práci jsem rozdělil na čtyři hlavńı části a to představeńı výuky na tomto pra-
covǐsti, obecný popis možnost́ı systému PDM, popisu vlastńı instalace systému a nast́ıněńı
trend̊u do budoucna. Tato práce by také měla napomoci otevřeńı již třet́ıho kurzu zabý-
vaj́ıćıho se problematikou

”
velkých CADů“.



Kapitola 1

Výuka CA . . . systémů na UETE

1.1 Metoda parametrického konstruováńı

Parametrické konstruováńı je metoda, která přestává být výsadou velkých CADů a vývo-
jáři ji zač́ınaj́ı implementovat i v oblasti CAD systémů středńı tř́ıdy. Umožňuje, aby CAD
nebyl jen náhradou kresĺıćıho prkna, ale výkonným pomocńıkem, usnadňuj́ıćım návrh
nového výrobku s možnost́ı rychlého posouzeńı řady rozměrových variant.

Logika myšleńı vedoućı k parametrizaci výkres̊u a model̊u je značně odlǐsná od logiky
použ́ıvané při práci s klasickým CADem, který nevyuž́ıvá metodu parametrického kon-
struováńı. Proto je výuka těchto systémů specifická a zvládnut́ı metody parametrického
konstruováńı je podmı́nkou zvládnut́ı práce s velkým CADem.

Co je tedy hlavńı odlǐsnost́ı této metody? U klasického CAD systému (např. Auto-
CAD verze 14) nakresĺıme např. čáru délky 100 jednotek a pak ji okótujeme. Chceme-li
změnit jej́ı délku na např. 120 jednotek, muśıme protáhnout tuto čáru a pak ji znovu
okótovat, př́ıpadně se asociativńı kóta přizp̊usob́ı čáře automaticky. Tedy kóty jsou ř́ızeny
geometríı. U systému už́ıvaj́ıćıho metodu parametrického konstruováńı (např. Design View
nebo CADDS5) je tomu právě naopak. Geometrie je ř́ızena kótami. V našem př́ıpadě tedy
nakresĺıme myš́ı čáru libovolné délky, okótujeme ji a pak změńıme hodnotu kóty na 100
– délka čáry se automaticky uprav́ı. Daľśı změnou hodnoty kóty na 120 pak čáru prod-
louž́ıme. Situaci ilustruje obrázek 1.1.

Kótě je také možné přǐradit tzv. parametr, neboli proměnnou popisuj́ıćı hodnotu kóty.
Tento parametr je možné libovolně měnit, může vstupovat do matematických vztah̊u
apod. Obrázek se pak může pr̊uběžně překreslovat tak, jak se měńı hodnota parametru.
Tedy prostřednictv́ım parametr̊u lze ř́ıdit geometrii. Tyto možnosti přináš́ı velké množ-
stv́ı aplikaćı (např. návrh nových výrobk̊u v r̊uzných rozměrových řadách, mechanika,
elektromechanika atd.).

Které systémy metodu parametrického konstruováńı využ́ıvaj́ı? V tabulce 1.1 jsou
uvedeny některé př́ıklady takových systémů, které se vyučuj́ı na ústavu UETE při FEI
VUT v Brně.
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Obrázek 1.1: Rozd́ıl mezi klasickým a parametrickým zadáváńım rozměr̊u

Tř́ıda CADu Malý CAD Středńı CAD Velký CAD

Minimálńı HW PC 386 a vyšš́ı PC 486 a vyšš́ı Pracovńı stanice

Název systému Design View Ashlar Vellum CADDS5

Tabulka 1.1: Př́ıklady systémů využ́ıvaj́ıćıch metodu parametrického konstruováńı

1.2 Postupy při práci s CAD systémy použ́ıvaj́ıćımi

metodu parametrického konstruováńı

Při práci touto metodou se uplatňuje poněkud jiný postup vytvářeńı elektronického
výkresu. Základńı kroky a jejich pořad́ı mohou vypadat např́ıklad takto:

1. Návrh základńı geometrie – neńı třeba brát v úvahu rozměry, ale pouze celkové pro-
porce. Je nezbytné při tom věnovat pozornost geometrickým vazbám mezi objekty
(rovnoběžnost, kolmost, spojeńı vazebńıch bod̊u . . . ).

2. Zakótováńı objektu – kóty muśı být uchyceny přesně na konci entit, v uzlech a v
mı́stech s geometrickými vazbami. Objekt nesmı́ být překótován (v́ıce kót než je
potřeba, přebytečné kóty jsou většinou systémů považovány za informativńı, ne-
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maj́ıćı vliv na geometrii) ani podkótován (méně kót než je potřeba, objekt neńı jed-
noznačně určen, nekótované rozměry mohou dosahovat libovolných hodnot). Některé
rozměry jsou jednoznačně určeny geometrickými vazbami a ty se pak nekótuj́ı.
Obecně počet a umı́stěńı kót může být jiné, než je požadováno v klasickém CADu
nebo na technickém výkresu. Rozhoduj́ıćı je, aby objekt byl jednoznačně určen.

3. Upravit rozměry kót tak, aby rozměry objektu odpov́ıdaly výchoźımu stavu.

4. Přǐradit parametry.

5. Definovat matematické vztahy mezi parametry.

6. Úpravou parametr̊u resp. hodnot kót dostaneme požadované proporce.

Obrázek 1.2: Postup vytvářeńı výkresu metodou parametrického konstruováńı

Praktická činnost v jednotlivých bodech záviśı na použitém systému a řešeném problému.

1.3 Vhodná př́ıprava studenta pro výuku

1.3.1 Zásady pro výuku velkých CADů

Na základě předchoźıho výkladu lze odvodit základńı zásady pro výuku CAD systémů
už́ıvaj́ıćıch metodu parametrického konstruováńı a jejich realizace v kurzech zajǐst’ovaných
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ústavem elektrotechnologie. Tyto zásady jsou shrnuty v následuj́ıćıch bodech:

1. Je výhodné, když studenti maj́ı, před započet́ım studia velkého CADu, představu o
zp̊usobu práce s klasickým CADem. Neńı nutné rutinńı zvládnut́ı práce s nějakým
systémem, ale celková orientace a pochopeńı metody.

2. Nejdř́ıve je dobré se soustředit na zvládnut́ı metody jako takové. Vhodné je použit́ı
malého CADu1, rovinného systému s jednoduchým intuitivńım ovládáńım, kde odpa-
daj́ı komplikace se zvládnut́ım prostřed́ı programu a orientace v prostoru.

3. Výuku je vhodné rozdělit do dvou část́ı. Cca jednu třetinu času věnovat výkladu
př́ıkaz̊u, tedy ovládáńı programu jako takového a cca dvě třetiny času věnovat ap-
likaci řešeńı konkrétńıho problému z daného oboru.

4. Pro zvládnut́ı přechodu do 3D prostoru se opět doporučuje zvládnut́ı 3D modelováńı
v některém z klasických CADů2. T́ım odpadnou problémy s orientaćı v prostoru a
opětným výkladem základńıch metodických postup̊u3.

5. Vyvrcholeńım je pak výuka velkého CADu, respektive jeho modul̊u využ́ıvaj́ıćıch
diskutovanou metodu4. Je-li naplněn předchoźı bod, je možné veškerý čas věnovat
aplikaci metody parametrického konstruováńı ve 3D modelováńı.

1.3.2 Model výuky CAD systémů na UETE

Na základě předchoźıch údaj̊u o struktuře vyučovaných CAD systémů na UETE byl
vytvořen model výuky CAD systém̊u. Tento model je graficky znázorněn na obrázku 1.3.

Model ukazuje členěńı výuky CAD systémů středńı tř́ıdy do tř́ı na sebe navazuj́ıćıch
úrovńı. Má návaznost na výuku velkých CADů a následně umožňuje tvorbu ročńıkových
projekt̊u a diplomových praćı. Tento model je v současné době použ́ıván při výuce na
ústavu ETE.

1.4 Kurzy malých a středńıch CADů

Klasický CAD systém středńı tř́ıdy – AutoCAD – je vyučován v rámci kurzu Tvorba
technické dokumentace, který je povinný pro všechny studenty FEI.

Zájemci si mohou prohloubit zde źıskané znalosti v doporučeném kurzu CAD1, jehož
ćılem je rutinńı zvládnut́ı práce s AutoCADem. Rozsah kurzu je 3 vyučovaćı hodiny týdně.

Základy metody parametrického konstruováńı jsou vyučovány v doporučeném kurzu
Design View zaměřeném na rutinńı zvládnut́ı stejnojmenného programu a jeho aplikaćı.

1např. DesignView
2AutoCAD, CADKey, Personal designer
3solid modeling, surface modeling
4např. zde uváděný systém CADDS5
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Obrázek 1.3: Model výuky CAD systémů na UETE

Rozsah tohoto kursu je 3 vyučovaćı hodiny týdně. Ve cvičeńı jsou prob́ırány aplikace
programu Design View v oblasti mechaniky a elektromechaniky.

V oblasti 3D modelováńı (klasickou metodou) je nab́ızen kurz CAD2 – 3D modelováńı
v AutoCADu.

Kromě uvedených kurz̊u prob́ıhá ještě výuka kurzu Grafické editory, kde jsou studenti
během jednotlivých vyučovaćıch hodin seznamováni s větš́ım množstv́ım grafických edi-
tor̊u. Smyslem tohoto kursu neńı naučit studenty jednotlivé editory ovládat, ale umožnit
jim źıskat všeobecný přehled. Podrobné seznámeńı s konkrétńım editorem je student̊um
umožněno v př́ıslušném specializovaném kurzu. Zde jsou programu CADDS5 vyhrazeny
tři vyučovaćı hodiny po 1,5 hod. čistého času. Každá část je vlastně prezentaćı tř́ı kurz̊u:
CDZ, CDP, CDM5. Studenti, tak v minimálńım čase poznaj́ı smysl a princip práce systému
pracuj́ıćıho metodou parametrického konstruováńı, EPD a PDM, se kterým mohou být
podrobněji seznámeni ve výše uvedených kursech.

5Tento kurz byl letos nově otevřen a jeho výuka začne v zimńım semestru.
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1.5 Výuka velkých CAD systémů – CADDS5

1.5.1 Počátky výuky

Od roku 1995/96 se plánovalo zahájeńı omezené výuky, která byla dále rozšǐrována po-
dle vybaveńı ústavu a administrativńıch podmı́nek. V té době tehdeǰśı Ústav mechaniky
a poč́ıtačového konstruováńı disponoval dvěmi stanicemi INDY firmy Silicon Graphics6

a softwarovým baĺıkem CADDS5 firmy Computervision7. Výuka nakonec začala o rok
později ve školńım roce 1996/97.

Pro výuku bylo d̊uležité existuj́ıćı moduly systému CADDS5 rozdělit do skupin a vyučovat
je podle toho, jak se s nimi uživatel setká ve své praxi. A protože moduly systému CADDS5
můžeme roztř́ıdit do čtyř základńıch oblast́ı, které ukazuj́ı, že uvedený systém dokáže řešit
návazně celý problém TPV, byly tyto oblasti použity jako základńı rozčleněńı také pro
výuku. Tyto čtyři oblasti jsou:

1. Konstrukčńı návrh (design) – základem je parametrické objemové modelováńı

2. Analýza – metoda konečných prvk̊u, kontrola koliźı apod.

3. Tvorba technických výkres̊u – z existuj́ıćıch objemových model̊u

4. Výroba – programováńı NC kódu atd.

Toto nejzákladněǰśı rozděleńı skrývá celou škálu možnost́ı a odborných oblast́ı, které
systém zahrnuje. Zvládnut́ı v́ıce jak 85 modul̊u systému jedincem v praxi je nemožné a
bylo by i zbytečné. Každý uživatel v praxi voĺı ty moduly, které potřebuje ve své profesi.

Pro volbu modul̊u zavedených do výuky byly hlavńı tato kritéria:

• Zaměřit se hlavně na moduly, které jsou základem pro všechny profese a jejich
znalost je nezbytná k využit́ı ostatńıch modul̊u.

• Ukázat velký CAD jako úplný systém, který dokáže přenést tv̊urč́ı myšlenku od
jej́ıho počátku při hledáńı optimálńı varianty řešeńı problému při modelováńı, přes
tvorbu výkresové dokumentace, tvorbu sestav a detail̊u, až po př́ıpravu programu
pro NC stroj. Jde tedy o ukázku systému, jak v oblasti CAD, tak i CAM – základńı
osu TPV.

1.5.2 Kurzy, které jsou v současné době otevřené

Reálné zavedeńı zamýšlené výuky se setkávalo s problémy nejen v oblasti hardwarového
vybaveńı8, ale i v oblasti personálńı. Panovalo však silné vědomı́ toho, že přechod k

6poř́ızeny z rozpočtu ústavu a z finančńı dotace Grantové agentury ČR
7źıskán d́ıky úzké spolupráci s firmou Inter-Informatics Praha
82 kusy pracovńıch stanic
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výuce velkých CADů je př́ıkazem a potřebou doby9. Proto se i přes problémy pokračovalo
v intenźıvńıch př́ıpravách k otevřeńı nových dvou kurs̊u CDZ a CDP. Ve školńım roce
1996/97 pak byla zahájena pravidelná výuka kurs̊u:

CDZ – CADDS5 základy 3D modelováńı, viz kapitola 1.5.3

CDP – CADDS5 pokročilé modelováńı, viz kapitola 1.5.4

1.5.3 CADDS5 Základy 3D modelováńı

Tento základńı kurz je určen pro studenty těch obor̊u, kde lze předpokládat jeho využit́ı10.
Student̊um je doporučeno zapsat si kurz ve čtvrtém ročńıku, aby stihli absolvovat navazuj́ıćı
kurzy a zároveň, aby tyto znalosti mohli efektivně využ́ıt v praxi.

Ćılem kurzu je doćıleńı základńı orientace v systému, pochopeńı metodiky práce a
zvládnut́ı použit́ı modulu parametrického 3D modelováńı. Studenti se zde seznamuj́ı s
modulem z prvńı oblasti – Parametric Design11, kde se uč́ı vytvářet 3D modely metodou
parametrického modelováńı. Osvojuj́ı si postup práce potřebný k využ́ıváńı této metody,
která je zcela odlǐsná od explicitńı tvorby. Tento styl tvorby modelu je však velmi výhodný
při ztvárňováńı ideje modelu a hledáńı konečné varianty. Studenti jsou seznamováni také
s modulem Sketcher, který slouž́ı ke snadnému vytvářeńı 2D skic, které se následně
převáděj́ı do parametrického modeláře. Pokud je to pro daný tvar výhodné, modul slouž́ı
jako předstupeň parametrického modeláře.

Absolvent kurzu by měl být schopen použ́ıt CADDS5 pro řešeńı své diplomové práce.
Rozsah předmětu jsou 3 hodiny cvičeńı týdně, během kterého prob́ıhá i výklad nových
pojmů.

Předmět má následuj́ıćı obsah:

• orientace v prostřed́ı CADDS5 a základńı ovládáńı, zahájeńı a ukončeńı editace
výkresu, zadáváńı souřadnic, práce s obrazovkou

• v parametrickém 3D modeláři vytvářeńı základńıch primitiv a jejich umı́stěńı v
prostoru

• vytvářeńı geometrických vazeb

• booleovské operace s objekty – sjednoceńı, pr̊uniky, odeč́ıtáńı

• pokročilé editačńı nástroje – otvory, zaobleńı, zkoseńı . . .

• parametry – přǐrazeńı editace, matematické vztahy mezi parametry

9výsledky marketingové studie, podpora ze strany Grantové agentury, požadavky pr̊umyslu, zájem
student̊u . . .

10elektrické stroje, elektroenergetika, př́ıpadně obory FSI
11Parametrický návrh



1.5 Výuka velkých CAD systémů – CADDS5 10

1.5.4 CADDS5 pokročilé modelováńı

Na kurz CDZ navazuje daľśı, určený pro jeho výtečné absolventy, jehož ćılem je ori-
entačńı seznámeńı s daľśımi moduly CADDS5 (features, NURBS, explicit solid modeling)
a prohloubeńı rutiny v oblasti parametrického konstruováńı. Kurz je určen předevš́ım
student̊um letńıho semestru 4. ročńıku, kteř́ı se hodlaj́ı ucházet o zaměstnáńı v podnićıch
využ́ıvaj́ıćıch CADDS5 (např. koncern ABB) a rovněž budou využ́ıvat tento program pro
řešeńı diplomové práce.

Zde se studenti seznamuj́ı s daľśımi moduly z prvńı oblasti – Parametric Multipart
Design12 a Concurent Assembly Mock-Up13, dále prohlubuj́ı styl práce parametrického
modeláře a postupuj́ı od práce tvorby jednotlivého objemového modelu k tvorbě sestav z
vytvořených model̊u. I v tomto kroku si ověřuj́ı parametrický postup práce na této úrovni,
kdy každou změnu na modelu při tvorbě sestavy systém provede i v sestavě, kde je daný
model použit.

Ve druhé části stejného kurzu CDP pak pomoćı modul̊u třet́ı oblasti Solid detailing14

a CADDS Raster Mode studenti tvoř́ı výkresovou dokumentaci z vytvořených modul̊u.
Stále pracuj́ı v parametrickém režimu, takže i v této chv́ıli mohou pružně reagovat na
všechny př́ıpadné změny.

Rozsah předmětu jsou 3 hodiny cvičeńı týdně, během kterého prob́ıhá i výklad nových
pojmů.

Shrnut́ı předmětu v bodech:

• orientačńı seznámeńı s daľśımi moduly CADDS5 (features, NURBS, explicit solid
modelling)

• prohloubeńı rutiny v oblasti parametrického konstruováńı

• vytvářeńı sestav, úvod do concurent engineering

• detailńı seznámeńı s draftingem

1.5.5 Připravovaný kurz CADDS5 CAM/PDM, analýza

Ústav zavád́ı třet́ı kurz CDM, který je již otevřen pro následuj́ıćı zimńı semestr, obsahuj́ıćı
moduly z oblast́ı analýza, výroba a podniková správa informaćı, kterou se zabývá tato
práce. V prvńım př́ıpadě jde o moduly řeš́ıćı kinematickou analýzu a modul Interference
Checking umožňuj́ıćı automatické zjǐst’ováńı koliźı mezi d́ıly sestav nebo těles v rámci
modelu. Ve druhém př́ıpadě se jedná o moduly CVNC, CVNC Batch Processing a CVGP
II, ve kterém by studenti završili vývoj tv̊urč́ı myšlenky přes návrh a tvorbu výkresové
dokumentace vytvořeńım NC kódu pro jednotlivé modely. Ve třet́ı části by se studenti měli
naučit organizovat veškeré informace o výrobku pomoćı systémů Opterga a SmarTeam,
jejichž implementace tématem této práce.

12Parametrický návrh konstrukčńıch sestav
13CAMU – Simultánńı práce ve velkých sestavách
14Tvorba výkresové dokumentace
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Systém kurz̊u a vyučovaných př́ıklad̊u tedy ukazuje velký CAD jako úplný nástroj
k přeneseńı tv̊urč́ıho nápadu od myšlenky až po úplnou realizaci. Při tomto praktickém
použ́ıváńı studenti poznávaj́ı možnosti výše uvedených nástroj̊u a řeš́ı následuj́ıćı požadavky:

1. Zkráceńı doby TPV.

2. Provázáńı jednotlivých
”
ostr̊uvk̊u TPV“ a odstraněńı problémů s t́ım souvisej́ıćıch.

3. Pomoćı analýzy včasné opravy nalezených problémů.

4. Nepřetržitá dostupnost aktuálńıch informaćı o výrobku.



Kapitola 2

Řešeńı pomoćı technologie PDM

2.1 Product Data Management jako cesta k úsporám

V podstatě muśıte efektivněji využ́ıt čas, který máte k dispozici. Je zapotřeb́ı dosáhnout
úspor času, respektive odbourat či maximálně zkrátit podp̊urné činnosti Vaš́ı práce a moci
se tak déle věnovat hlavńı činnosti.

Nejprve je nutné si ujasnit, čeho vlastně chcete dosáhnout. Proč je nutné ušetřit čas
v rámci vývojového procesu: Je to proto, že chcete zkrátit čas potřebný pro určitý krok
v procesu, anebo proto, že konkurence na změny reaguje rychleji než vy? Je doba výroby
př́ılǐs dlouhá? Pracujete přes čas, a přesto nemáte dost času k tomu, abyste provedli
práci ekonomicky a pořádně? Snaž́ıte se naj́ıt kombinaci všech těchto a mnoha daľśıch
faktor̊u, a docháźıte tak ke zjǐstěńı, že vlastně potřebujete uspořit čas, abyste dosáhli
vyšš́ı ziskovosti.

Většina společnost́ı dnes stoj́ı před několika hlavńımi úkoly. Všechny vedou ke zvyšováńı
tlaku na využit́ı dostupného času v rámci organizace.

• Trhy se d́ıky deregulaćım velmi rychle měńı. Mı́sta na trhu jsou po celém světě
otevřeněǰśı. Zákazńıci si pečlivěji vyb́ıraj́ı a maj́ı náročněǰśı požadavky. To znamená,
že produkt, který vyv́ıj́ıte, muśı být vyvinut rychleji. Produkty a také výrobńı pro-
cesy jsou stále komplexněǰśı. Muśıte tedy co nejekonomičtěji využ́ıt čas, který máte
k dispozici. To můžete dosáhnout automatizaćı proces̊u, zvyšováńım osobńıch ćıl̊u
atd.

• Zat́ımco se zvyšuje komplexnost produktu a procesu, životńı cyklus produktu se
zkracuje, což znamená, že muśıte produkovat komplexněǰśı produkt za použit́ı kom-
plexněǰśıch proces̊u, a to za kratš́ı dobu.

Základńım bodem je, že technologie jako PDM, PIM, CAD/CAM se muśı shodovat se
změnou procesu v rámci organizace, aby bylo dosaženo požadovaných př́ınos̊u. Jedńım z
velkých problémů, před kterými stoj́ı mnoho organizaćı, je práce s množstv́ım dat uvnitř
organizace. Data nebo informace jsou jedńım z kĺıčových zdroj̊u. Jak jsou data ř́ızeny,
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organizovány a použ́ıvány v rámci organizace jsou rozhoduj́ıćı faktory v otázce úspěchu
a neúspěchu organizace.

Jedńım z následk̊u špatné organizace nebo ř́ızeńı dat je, že lidé tráv́ı spoustu času
hledáńım informaćı, namı́sto toho, aby je měli možnost použ́ıt.

Obrázek 2.1 ukazuje výsledky

Obrázek 2.1: Využit́ı inženýrova času

několika r̊uzných studíı o tom, kde
a jak pr̊uměrný inženýr tráv́ı sv̊uj
pracovńı den1. Největš́ı část, která
ale přes to tvoř́ı pouze 40 % je čas,
který inženýr věnuje své vlastńı
práci a funkci. Čtvrtina jeho celko-
vého času je určena pro hledáńı
informaćı, tzn. při osmihodinové
pracovńı době jsou to 2 hodiny.
Daľśıch 12 % je použito pro komu-
nikaci a přenos informaćı v rámci
organizace, dodáváńı informaćı dal-
š́ım lidem. Šest procent času je ur-
čeno na opětovné vytvořeńı těch
dat, která nemohou být nalezena
nebo nebyla nalezena dostatečně rychle. Posledńı část jsou

”
záhadně ztracená procenta“,

představuj́ı 18 % a nikdo pro ně zat́ım nenašel vysvětleńı. Zamyslete se tedy nad t́ım,
co by znamenalo, kdybyste zvýšili ze 40 % na 50 % tu část, kterou každý inženýr věnuje
své vlastńı práci, zhodnocuje nebo vytvář́ı hodnoty. Rovnalo by se to desetiprocentńımu
navýšeńı inženýrských zdroj̊u, přičemž nemuśıte fyzicky zvýšit počet lid́ı v organizaci.
Toto 10% navýšeńı je dnes zcela reálný ćıl, kterého již mnoho společnost́ı dosáhlo nebo
jej i překročilo.

2.2 Zp̊usoby práce v organizaćıch

V nejnižš́ı hladině se PDM zaměřuje právě na problematiku zajǐstěńı centrálńıho zdroje
přesných a spolehlivých informaćı pro správné osoby ve správném čase.

Obrázek 2.2 představuje schematicky typ fungováńı organizace, který se ještě nacháźı
v mnoha společnostech. Je to

”
sériový pracovńı proces“ a

”
systém odděleńı“. Většinou

zde existuj́ı jakési psychologické bariéry mezi jednotlivými odděleńımi. Odděleńı pracuj́ı
na svých úkolech odděleně a když splńı svou část úkolu,

”
hod́ı“ svoji práci

”
přes bariéru“

daľśımu odděleńı. To může být např. technické odděleńı, které bude pokračovat s analýzami,
některé z nich budou v pořádku, takže to předaj́ı přes daľśı bariéru do výrobńıho odděleńı.
Ovšem ty části, které v pořádku nebyly, muśı předat zpět do návrhového odděleńı. Při
tomto typu ř́ızeńı však komunikace vázne. Trvá velmi dlouho proj́ıt všemi procesy, aby-
chom vyrobili hotový produkt a výsledkem je dlouhá doba vývoje – nekonkurenceschop-

1Zdroj [1]
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Obrázek 2.2: Sériový model podnikových činnost́ı

nost. Takové organizace jsou také charakteristické relativně malou flexibilitou, maj́ı pro-
blémy reagovat na nenadálé změny v rámci svých trh̊u. Jedńım z nejvýznamněǰśıch
problémů s t́ımto typem př́ıstupu je, že je velmi obt́ıžné objevit potenciálńı nebo skutečné
problémy v návrhu produktu v celém procesu tak brzy, aby je bylo možné napravit levně a
efektivně. To může vést k situaćım, kdy je produkt už ve výrobě nebo dokonce v provozu
a muśı na něm být provedeny změny. Takové změny jsou pak velmi časově i finančně
nákladné.

Daľśı zp̊usob organizace vývojového

Obrázek 2.3: Souběžné zpracováńı

prostřed́ı produktu spoč́ıvá v souběžné
práci. To znamená, že všechny strany
zúčastněné v procesu vývoje produktu
maj́ı př́ıstup k informaćım, které potře-
buj́ı a právě v době, kdy je potřebuj́ı.
Tedy jednotlivá odděleńı pracuj́ı souběž-
ně a maj́ı př́ıstup k d́ılč́ım výsledk̊um os-
tatńıch odděleńı. Tento zp̊usob spoč́ıvá
ve formováńı týmů v rámci organizace,
např́ıč přes hranice jednotlivých odděleńı,
podle spolupráce na jednom určitém pro-
jektu. Všichni spolupracovńıci při tom
samozřejmě nesed́ı v jedné kanceláři, nain-
stalovaná technologie PDM zajǐst’uje a
distribuuje informace a také ř́ıd́ı procesy spojené s takovým zp̊usobem návrhového pros-
třed́ı. PDM je technologie spravuj́ıćı vztahy mezi produkty, lidmi, procesy, daty a ap-
likacemi použitými k vytvořeńı dat.

Ke zlepšeńı vývojových proces̊u použijeme trojrozměrný CAD model jako master2

model pro všechny následné aplikace, např. obráběńı, kresleńı, analýzy apod. Význam
použit́ı 3D CAD geometrie jako master modelu spoč́ıvá v tom, že nemuśıte koṕırovat
základńı informace do několikanásobných lokalit v rámci organizace, což se obvykle během
sériového procesu stává. Lidé potřebuj́ı mı́t př́ıstup ke stejným informaćım ve stejný

2hlavńı nebo ř́ıd́ıćı
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okamžik, takže se informace koṕıruj́ı, což vede ke značným komplikaćım při reviźıch či
změnách. Lidé nedostávaj́ı automaticky aktualizované informace, takže mnohdy pracuj́ı
se zastaralou verźı dat. Jedna z nejvýznamněǰśıch výhod tohoto typu př́ıstupu spoč́ıvá v
tom, že práce na následných aplikaćıch, jako kresleńı, analýzy atd., mohou ve skutečnosti
zač́ıt ještě před t́ım, než je konečný návrh součástky nebo sestavy hotov. To znamená, že
analýza může zač́ıt v mnohem dř́ıvěǰśım stádiu návrhového procesu, výsledky se zpětně
předaj́ı designér̊um a ti již mohou provést tyto změny v digitálńı podobě dávno před t́ım,
než se cokoliv fyzicky vyrob́ı. Výsledkem je značná úspora celkového času.

2.3 Koncepce a charakteristiky PDM

Jedńım z prvńıch úkol̊u je integrovat data nebo informace o produktu a také aplikace, které
vytvářej́ı a použ́ıvaj́ı tato data. Současně muśı být v rámci organizace umožněn sd́ılený
př́ıstup k veškerým dat̊um o produktu. Daľśı oblast́ı PDM je samotné ř́ızeńı proces̊u, které
jsou použ́ıvány v organizaci. Např. změna ř́ıd́ıćıch procedur, vydávaćıch procedur, schval-
ovaćıch procedur. Nejsou to jen formálńı procesy, ale také neformálńı, které maj́ı rostoućı
tendenci v rámci organizace. Jeden z daľśıch d̊uležitých bod̊u je, že je umožněno zachytit
nejlepš́ı praktiky nebo postupy v organizaci a znovu je použ́ıt. Informace je zachycena, aby
se podařilo zlepšit proces, a může být potom rozš́ı̌rena a znovu použita v rámci organizace.
V PDM/PIM systému se vytvář́ı databáze informaćı o produktu. Celopodnikové řešeńı
umožńı všem odděleńım v organizaci př́ıstup k těmto dat̊um. Také umožňuje zachytit pro-
cesy, které se použ́ıvaj́ı, a ustavičně pracovat na jejich zlepšeńı. Zajǐst’uje také kontrolu
obchodńıch pravidel, zabezpečeńı dat a integritu, konzistenci proces̊u, které se použ́ıvaj́ı.
Posledńım bodem je, že data jsou vlastně transformována na informace, ze kterých plynou
znalosti v organizaci, a ty mohou být znovu použity, když jsou zapotřeb́ı.

Zavedeńı PDM technologie, spolu s

Obrázek 2.4: Nár̊ust ceny výrobku

vašimi současnými procesy, trochu zrychĺı
tyto procesy, ale to neznamená, že t́ım
doćıĺıte plně dosažitelného př́ınosu. Jed-
ńım z d̊uvod̊u pro úsporu času neńı jen
to, že tento čas ušetř́ıte, ale výsledná úspo-
ra finančńıch prostředk̊u a zvýšeńı zisku.
Odtud pocháźı rčeńı:

”
čas jsou peńıze“.

To se velmi dobře vztahuje na prostřed́ı
vývoje produktu. Č́ım dř́ıve je problém
nalezen, t́ım dř́ıve bude napraven a t́ım
levněǰśı úprava bude provedena. Jedńım
z d̊uvod̊u pro to je, že v prostřed́ı vývoje
produktu mnohé náklady, které se ob-
jevuj́ı během produkce, jsou zp̊usobeny
rozhodnut́ımi, které byly udělány mnohem dř́ıve v návrhovém procesu. Na základě rozhod-
nut́ı, která jsou učiněna v počátečńım stádiu návrhu, je rozhodnuto až o 70 % celkových
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náklad̊u na vývoj a výrobu produktu. Skutečný vliv r̊uzných odděleńı nebo funkćı se
prudce snižuje mimo návrhovou skupinu. Vývoj produktu a design nesou největš́ı zod-
povědnost za náklady v rámci organizace, takže maj́ı největš́ı potenciál pro zlepšováńı a
snižováńı náklad̊u.

Paralelńı prostřed́ı spolupráce je vysoce efektivńı zp̊usob př́ıstupu k tomuto problému,
protože umožňuje efektivněji kontrolovat návrhy a prověřovat, zda to, co se navrhuje,
bude vyrobitelné a bude fungovat. Toho je možné dosáhnout t́ım, že všem, kdo pracuj́ı ve
vývojové organizaci, bude umožněn snadný př́ıstup k aktuálńım informaćım o produktu,
včetně marketingových údaj̊u, standard̊u, CAD model̊u, výkres̊u apod. Concurrent en-
gineering3 se stává opravdu efektivńı, pokud je založen na PDM řešeńı, které je těsně
integrováno s použ́ıvaným CAD/CAM softwarem. Zavedeńı PDM technologie vedlo v
mnoha společnostech k významným úsporám v čase př́ıpravy a zlepšeńı prvotńı kvality.

2.4 Dosažitelné př́ınosy

Prvńı, a řekl bych nejvýznamněǰśı, př́ınos je, že umožňuje uživateli, aby se soustředil na
podstatu své práce. Vyhledáváńı a lokalizace dat se stává mnohem snažš́ı a uživatelé
se mohou soustředit na podstatu své práce. Současně umožňuje lépe a v́ıce použ́ıvat
stávaj́ıćı návrhy, standardńı části a procesy, protože je lze snadno a rychle naj́ıt. Daľśım
faktorem je, že funguje jako katalyzátor kulturńıch změn v organizaci. Již jsem uvedl, že
jedńım z faktor̊u úspěšné implementace je změna proces̊u v organizaci. Společnost muśı
být připravena provést změny, aby z PDM řešeńı źıskala maximum. PDM také zajǐst’uje
automatizaci rutinńıch úkol̊u, jako jsou výstupńı procedury, schvalovaćı procedury. Má
vliv na flexibilitu lid́ı v organizaci, protože kvalita dostupných informaćı se zvyšuje a
zlepšuje se také kvalita rozhodováńı managementu.

Výsledky studíı zpracované mnoha lidmi (Business Week, Arthur D. Little atd.) v
oblasti managementu a ř́ızeńı návrhového prostřed́ı ř́ıkaj́ı, že lze uspořit až 30 % času.
Znovupoužit́ı informaćı se zvýš́ı, takže dosáhnete lepš́ıho využit́ı existuj́ıćıch informaćı
v organizaci. Lze uspořit až 80 % času, který v současnosti zab́ırá distribuce informaćı.
Odpad nebo množstv́ı oprav, které muśı být provedeny, má rychle se snižuj́ıćı tendenci. V
těchto př́ıpadech se jedná až o 75 % času. Výrobńı náklady se sńıž́ı. Počet požadovaných
změn produktu se také výrazně sńıž́ı – v mnoha př́ıpadech je reálných až 50 %. Návrhový
cyklus se může celkově zkrátit až o 60 %.

2.5 Praktické ukázky dosažených př́ınos̊u

Tyto informace shromáždila společnost CIMdata Inc. USA.
U bombardéru B2 byla dosažena 97% úspěšnost montáže nově navržených část́ı na

prvńı pokus. To znamená, že 97 % všeho, co bylo vytvořeno za použit́ı nové technologie,

3Volně přeloženo: souběžné zpracováńı
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pasovalo dohromady na prvńı pokus, když se začala provádět fyzická montáž. Bylo tak
ušetřeno 50 milión̊u dolar̊u.

Program ATFV, All Terain Fighting Vehicle, terénńı vojenské vozidlo, dosáhl sńıžeńı
času vývoje pohonné sekce vozidla o 87 %.

Westinghouse se zaměřil na některé svoje produkty a na to, jak by mohl zlepšit celkový
výkon, a podařilo se mu dosáhnout některých fantastických výsledk̊u. Doba montáže se
sńıžila ze 6 týdn̊u na 2 hodiny, což se podařilo d́ıky lepš́ımu návrhu produktu a možnosti
kombinovat r̊uzné funkce dostatečně brzy v návrhovém procesu. Podařilo se eliminovat
na produktu 3,5 tiśıce svár̊u a počet výkres̊u, které je nutné vypracovat, z 200 na 3.

Jeden známý výrobce poč́ıtač̊u zredukoval př́ıpravný čas a montážńı náklady o 50 %.
Tyto úspory jsou založeny na implementaci PIM nebo PDM technologie.

Výrobce letadel sńıžil zaváděćı náklady celkově o 34 % a náklady spojené s inženýrskými
změnami o 55 %. Náklady na fyzickou výrobu se také sńıžily a př́ıpravný čas se zkrátil o
30 %.

Jedńım z problémů v mnoha organizaćıch je velký počet r̊uzných systémů, které muśı
být použity. CAD systémy, CAM systémy, analýzy, plánováńı produkce atd. Opět zde
mám jeden př́ıklad, tentokrát se jedná o výrobce kabel̊u. Racionalizaćı proces̊u a systémů,
které pož́ıval, dokázal sńıžit počet opakovaného zadáváńı stejných dat do r̊uzných systémů
ze 41 opakováńı před zavedeńım PDM na 6 opakováńı s technologíı PDM. To významně
přisṕıvá ke sńıžeńı možných chyb nebo jejich zdroj̊u.

Daľśı př́ıklad pocháźı z izraelského leteckého pr̊umyslu a týká se letadla Galaxy. Celý
projekt byl dokončen včas, přestože partner, který byl zodpovědný za významnou část
letadla, odešel v polovině práce. Dı́ky implementaci PDM systému pro ř́ızeńı návrhového
procesu byl projekt dokončen včas. Nebyl vyroben žádný fyzický model před zahájeńım
výroby. Vyroben byl jeden prototyp a všechny části bylo možné smontovat na prvńı pokus,
bez jakýchkoliv chyb.

Posledńı př́ıklad je od Motor Coach, výrobce autobus̊u v Kanadě. Rozhodla se pro
dvouletou implementaci PDM spojenou s EDS kv̊uli velkým problémům s propadaj́ıćım
pod́ılem na trhu a klesaj́ıćı ziskovost́ı. Začala vyrábět zcela nový autobus, moderněǰśı pro-
dukt než měli doposud. Na základě PDM bylo dosaženo zkráceńı zaváděćıho času na trh o
50 %. Všechny cykly se výrazně zkrátily a 99 % nového autobusu bylo definováno digitálně.
Byl modelován v CAD systému a testován digitálně ještě před výrobou prototypu.



Kapitola 3

Zavedeńı výuky PDM do předmětu
CADDS5

3.1 Systém Optegra

3.1.1 Stručné představeńı vlastnost́ı

Tento systém poskytla ústavu firma InterInformatics s.r.o., která zastupuje v České re-
publice výrobce Parametric Technology Corporation. Původně byl tento systém dostupný
pouze na platformě SUN, ale v současnosti je k dispozici na všech hlavńıch platformách,
ze kterých nás zaj́ımaj́ı systémy SGI IRIX a MS Windows.

Jedná se o systém skupinové správy dat pro CADDS5, který se snaž́ı změnit informace
o výrobćıch na obchodńı výhody. Společnost PTC je jednak dodavatelem Optegry a také
CADDS5, to poskytuje otevřené informačńı prostřed́ı, které pomáhá výrobc̊um flexibil-
ně a pr̊uhledně ř́ıdit, kontrolovat a distribuovat všechny druhy CADDS5 i jiných non-
CAD informaćı společných pro daný výrobek. Architektura Optegry informuje uživatele
– od vývoje přes technologii po prodej a marketing – umožňuje prohĺıžeńı, lokalizaci
a zpř́ıstupněńı jakékoliv informace z osobńıho poč́ıtače a pracovńı stanice, v lokálńı
nebo rozsáhlé śıti, podporuje připojeńı přes intranet nebo internet. Zajǐst’uje dostupnost
veškerých informaćı o produktu nezávisle na tom, ve které kanceláři, budově či státu se
právě nacháźıte – od návrhu až po podporu ke starš́ım výrobk̊um.

Vlastńı program je rozdělen na dvě základńı části:

Vault1 – je srdcem tohoto distribuovaného správńıho systému dat. Zjednodušuje správu
systému, poskytuje funkce pro tř́ıděńı, tř́ıd́ı a katalogizuje údaje o objektech podle
vlastńıka, odděleńı, materiálu – podle jakékoliv vlastnosti, která je d̊uležitá pro
daný proces. Distribuovaný Vault poskytuje škálovatelnost, která dovoĺı spojit r̊uzné
Vaulty do jednoho logického celku, uživatelé tak mohou snadno shromažd’ovat, ř́ıdit,
koṕırovat a źıskávat informace o produktu, bez ohledu na platformu nebo umı́stěńı.

1trezor, sejf, (server pro uložeńı dat)
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EPD.Connect2 – je navržen k daľśı podpoře spolupráce ve v́ıceuživatelském souběžném
pracovńım prostřed́ı. Umožňuje návrhář̊um dynamicky vytvářet, prohĺıžet a mani-
pulovat s jediným master modelem produktu, zhodnotit shromážděnou strukturu a
3D pohledy. Protože uživatelé mohou okamžitě vidět části přidávané svými kolegy,
návrhy jsou sd́ılené a problémy je možné vyřešit včas ještě ve vývoji. Uživatelé mo-
hou animovat 3D modely produktu a prohĺıžet nebo testovat dokonce i velmi kom-
plexńı produkty. At’ se pod́ıĺıte na výrobě nebo se staráte o údržbu, s EPD.Connect
se pomoćı vituálńıho modelu ihned seznámı́te s reálným stavem.

3.1.2 Instalace

Pod OS Windows 95/NT4

1. Po vložeńı CD do mechaniky se bud’ spust́ı automaticky setup.exe nebo ho spust́ıme
z kořenového adresáře ručně.

2. Vybereme požadovaný jazyk pro instalaci, ovšem na výběr máme pouze angličtinu
nebo japonštinu.

3. Seznámı́me se s licenčńım ujednáńım a odsouhlaśıme ho tlač́ıtkem Next.

4. Zvoĺıme adresář pro instalaci, necháme C:\EPD\dm\v300

5. Vybereme komponenty, které chceme instalovat:

EPD.Connect – klient pro vzdálené připojeńı k Vaultu

Locator – použ́ıvá se s Vault v client–server systémech, organizuje a ř́ıd́ı libovolné
elektronické dokumenty

Workflow Client – pro zadáváńı pracovńıch proces̊u, vazeb mezi pracovńıky, úkol̊u,
instrukćı a vztah̊u pro jednotlivé uživatele

Vault Server – samotný server Optegry (pouze pro NT4)

Licence – pokud je nainstalován CADDS5, tak neńı potřeba

CM Agent – pro manipulaci s konfiguraćı jednotlivých projekt̊u – ovládá vztahy,
umožňuje prohĺıžet produktu ve vztaźıch funkćı, času, efektivity . . .

6. Zvoĺıme název programové skupiny, neńı potřeba měnit, necháme EPD.Connect and

Optegra

7. Zkontrolujeme nastaveńı instalačńıho programu, k předchoźım nastaveńım se vždy
můžeme vrátit tlač́ıtkem Back, potom spust́ıme instalaci. Na disku potřebujeme 60
až 100MB volného mı́sta.

2klient pro vzdálené připojeńı k Vaultu
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Po ukončeńı instalačńıho programu je ještě nutné, v závislosti na konkrétńıch podmı́nkách,
upravit konfiguračńı soubory.

config.sys – nutná úprava, přidáme řádek: shell=c:\command.com /P /E:4096

cvepd.ini – hlavńı konfiguračńı soubor umı́stěný v adresáři s operačńım systémem, ob-
vykle c:\windows resp. c:\winnt

Ostatńı konfiguračńı soubory jsou umı́stěny v \EPD\dm\v300\data\reposit, tyto soubory
obsahuj́ı defaultńı nastaveńı a neupravuj́ı se, položky, které chceme změnit okoṕırujeme
do cvepd.ini, který má nejvyšš́ı prioritu.

cfgwin95.ini – nastaveńı některých d̊uležitých proměnných

PERL PATH – cesta k interpretu jazyka Perl

CA COLOR – barva prostřed́ı

CA FONT – základńı font prostřed́ı

CVEPD SCR CONFIG – konfigurace pro dané rozlǐseńı monitoru

epdconn.ini – soubor všech proměnných

EPD HTMLBROW NAME – nastaveńı web browseru

EPD HTMLBROW DIR – nastaveńı web browseru

EPD HTMLBROW CMDFMT – nastaveńı web browseru

EDM O SERVER – jméno serveru

EDM AVAILABLE – 0 – bez serveru, 1 – bude se připojovat server

explorer.ini – konfiguračńı soubor pro viewer

CVDPA VIS NAME=$CVDPA EPD3dViewer COMM – zapoznámkovat

CVDPA VIS NAME=$CVDPA Visualizer COMM – odpoznámkovat

u verze 2 ještě nutno zapoznámkovat CVDPA EPD3dViewer COMM=$CA BINDIR... a
do CVDPA EPD3dViewer COMM vložit obsah proměnné z visualizéru

epdview.ini – nastaveńı vieweru, neńı potřeba nic měnit

Nakonec ještě upravit u spouštěćıho př́ıkazu, pracovńı adresář
c:\EPD\dm\v300\parts\read. Pomoćı této ikony pak spust́ıme hlavńı pro-
gram.
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Pod OS IRIX

1. Na CD v adresáři /install nebo v našem př́ıpadě z /usr2/mips irix6/install

spust́ıme instalačńı program slic v grafickém prostřed́ı

2. Zvoĺıme režim expert.

3. Otevře se okno, kde vybereme instalované součásti:

Manager – neńı potřeba

EPO – neńı potřeba pokud je CADDS5, součásti pro visualizaci

Optegra all clients

EPD Connect – v options vybrat verzi CADDS5

EPD Visualizer – prohĺıžeč

EPD Explorer – v options zvoĺıme podporu pro danou verzi CADDS5

Optegra Vault client – pokud je na stanici instalován server

4. roletka Disk Space → File Space otevře okno, ve kterém vid́ıme jednotlivé oblasti,
volné mı́sto na nich a kolik mı́sta je potřeba podle toho jaké součásti jsme zvolili.
Pokud v instalačńım adresáři neńı dost mı́sta, postupujeme podle instrukćı dále v
textu.

5. V instalaci pokračujeme: roletka Install → Install

6. Po dokončeńı: roletka File → Quit

Před daľśım postupem je třeba upozornit, že UNIX systémy jsou CaseSensitive, tzn.
v př́ıkazech a jménech soubor̊u rozlǐsuj́ı velká a malá ṕısmena, takže např. install a
Install jsou dva rozd́ılné soubory. Ve Windows se v adresářové struktuře jednotlivé
adresáře odděluj́ı znakem \, naproti tomu v UNIX systémech se použ́ıvá /.

Program se nainstaluje do /opt/EPD/dm/v320 př́ıpadně ... /vXXX, kde mı́sto XXX se
dosad́ı č́ıslo instalované verze. Množstv́ı volného prostoru zjist́ıme př́ıkazem df, který nám
zobraźı volný prostor na všech namountovaných oblastech, pro snažš́ı odečteńı můžeme
použ́ıt přeṕınač -k (info v kilobytes). Budeme potřebovat cca 100MB, pokud neńı na /opt

mı́sto, použijeme př́ıkaz ln -s <cı́l> <jméno odkazu>, který vytvoř́ı symbolický odkaz
do jiného adresáře na oblast, kde je potřebné volné mı́sto. Př́ıslušný adresář vytvoř́ıme
př́ıkazem mkdir <jméno>.

V našem konkrétńım př́ıpadě je ćılový adresář /usr2/epd/dm/v200

cvepd.ini – hlavńı konfiguračńı soubor je tentokrát umı́stěný v instalačńım adresáři,
tedy /opt/EPD/dm/v320. Zde v něm provád́ıme potřebné změny, které jsou shodné
s instalaćı do Windows.
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JAVA – systém pro zobrazováńı dialog̊u, který je někdy potřeba vyřadit z činnosti kv̊uli
čitelnosti. Pouze pro verzi 3.

epdconn.ini – nacháźı se v adresáři v320/data/reposit

#Sets the preference for the InfoBrowser

#’AW IB’ – old infobrowser

#’JAVA IB’ – java infobrowser

IB MODE=AW-IB

dokončeńı konfigurace – provád́ı se na jednotlivých uživatelských účtech většinou
správcem systému nebo jednotlivými uživateli. Uživatelský adresář je v našem př́ıpadě
/usr/people/cadds5 V souborech:

.login

set path=(\$path /usr/apl/cadds/{access,bin,data,scripts,

data/valisys/util} /opt/epd/dm/v300/{scripts,bin,data} )

setenv LANG C

.cshrc

setenv EDM_HOME /opt/epd/dm/v320

setenv EPD_HOME /opt/epd/dm/v320

Aby se tyto změny projevily, je potřeba se odlogovat a znovu přilogovat.

navsetup – Pokud chceme systém propojit s CADDS5 je potřeba z adresáře
/opt/epd/dm/v320/install spustit tento program, jsme-li v uvedeném adresáři
použijeme pro spuštěńı zmı́něný př́ıkaz takto ./navsetup. Po spuštěńı zadáme č́ıslo
verze CADDS5, pro kterou se má doistalovat podpora.

caddsrc-local – nutná úprava na konec řádku setenv CVPATH $HOME/parts=... přidat
:/home/cadds5/parts:/home

cvepd.ini – základńı ovládaćı okno programu se dá přizp̊usobit potřebám konkrétńıho
uživatele, nejprve je však nutné provést následuj́ıćı úpravy v konfiguraci:
v $home/cadds5 je již umı́stěn soubor cvepd.ini

AWLANG=C – pod tento řádek přidáme: INFB DEF FILE=$HOME/inf def.txt

inf def.txt – okoṕırujeme z adresáře /opt/epd/dm/v320/data/infbrows/defn/C

inf def.txt – je určen pro UNIX

inf def1.txt – je určen pro Windows

Spuštěńı provedeme př́ıkazem Connect

Po spuštěńı, když chceme pracovat s CADDS5, se muśıme přepnout ze Structure do
Assembly.
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3.1.3 Popis ovládáńı programu

Po spuštěńı EPD.Connect se nám otevře hlavńı ovládaćı okno, které je na obrázku 3.1,
pomoćı něj máme př́ıstup ke všem hlavńım funkćım systému.

Obrázek 3.1: Hlavńı okno systému Optegra

Toto okno je rozděleno na 3 části:

• v horńı části je menu, které lze ovládat myš́ı nebo pomoćı klávesnice a obsahuje
všechny př́ıkazy

• prostředńı proužek obsahuje ikony pro rychlé spuštěńı př́ıkazu myš́ı, ikony a jejich
funkce se daj́ı upravit v konfiguračńım programu

• ve spodńım řádku se zobrazuj́ı r̊uzná systémová hlášeńı informuj́ıćı o prováděných
operaćıch

Ikony maj́ı tyto funkce3:

Práce s programem

• ukončeńı programu

• nový projekt

• otevřeńı projektu

• zavřeńı projektu

• uložeńı otevřeného projektu

Operace s označenými objekty

3prvńı je vždy vlevo, posledńı vpravo
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• uložit označené komponenty do schránky a smazat

• koṕırovat označené komponenty do schránky

• vložit označené komponenty ze schránky

• zpět o jednu operaci

• znovu provést odvolanou operaci

• zopakovat provedenou operaci

• zaměnit operace

Operace se stromovou strukturou projektu

• vybrána bude pouze položka, na kterou klikneme – označeńı dř́ıve vybrané položky
se zruš́ı

• vybrány z̊ustanou všechny položky, které označ́ıme

• vybrána bude položka, na kterou klikneme a všechny položky na ńı závislé

• spojovaćı čáry jednotlivých komponent budou kolmé

• spojovaćı čáry jednotlivých komponent budou šikmé

• zobrazeńı komponent ve stylu souborového manažeru

• vysv́ıt́ı označené komponenty

• vysv́ıt́ı neoznačené komponenty

• zruš́ı vysv́ıceńı

Otev́ıráńı pomocných oken

• okno se strukturou projektu

• přehledové okno struktury projektu
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• okno zobrazuj́ıćı schránku

• okno pro komunikaci se serverem

• načteńı označených komponent pro vizualizaci

• vymazáńı označených komponent

Daľśım velmi d̊uležitou část́ı je okno struktury projektu, které je na obrázku 3.2.
Můžeme zde vidět jak na sebe navazuj́ı jednotlivé d́ıly od hlavńıch část́ı až do posledńıho
šroubu.

Obrázek 3.2: Okno struktury projektu systému Optegra

Jednotlivá okénka reprezentuj́ı části, kterým je možné přǐradit vlastnosti jako např.
hmotnost či materiál a rovněž zadat hodnotu určené veličiny. Význam jednotlivých tlač́ıtek
je následuj́ıćı:

1. Structure overview – přehledové okno struktury projektu

2. Vault Browser – okno pro nač́ıtáńı komponent ze serveru

3. Component Status – okno s podrobnými informacemi o označené součásti

4. Memory Control – pro úschovu projektu v paměti

5. Compare Options – porovnáńı vlastnost́ı objekt̊u

6. Print Tree – tisk stromové struktury projektu

7. Edit Properties – také menu File → Properties, otevře okno vlastnost́ı označeného
objektu, kde můžeme definovat či editovat již zmı́něné vlastnosti, např. materiál,
hmotnost a libovolné daľśı. Také můžeme připojovat libovolné dokumenty jako
př́ılohy.
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8. Session Summary – celkové informace o projektu

9. Collapse Window – zmenšeńı okna

10. Expand Window – zvětšeńı okna

Okno EPD Desktop z obrázku 3.3 nám zpř́ıstupňuje veškerá data o projektu.

Obrázek 3.3: Okno př́ıstupu k informaćım systému Optegra

Je to přehledná stromová struktura, kde:

• Optegra Vault zpř́ıstupńı po zadáńı hesla informace uložené na serveru.

• Local ukrývá soubory na všech disćıch lokálńıho poč́ıtače.

• Optegra VaultAdmin zpř́ıstupňuje administrátorské funkce serveru.

• Vault Inbasket je schráka pro př́ıjem na server.

• CM – pod touto zkratkou jsou př́ıstupné všechny předdefinované typy dokument̊u,
prostřed́ı a jejich použit́ı.

• Workflow – informace o pracovńıch vztaźıch

Posledńı část systému, o které se zde zmı́ńım je na obrázku 3.4, je to samostatný pro-
gram maj́ıćı výstižný název Administrator. Pomoćı tohoto programu má administrátor
př́ıstup ke všem funkćım systému. Je možné zde upravovat nastaveńı uživatelských hesel,
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Obrázek 3.4: Okno administrátorských funkćı systému Optegra

konfigurace serveru pro vzdálený př́ıstup, zobrazeńı log souboru se všemi provedenými op-
eracemi, nastavováńı práv skupinám i jednotlivým uživatel̊um, správa reviźı jednotlivých
dokument̊u, možnosti uživatelsky definovaných atribut̊u součást́ı, výčty např. potřebných
materiál̊u, definice typ̊u objekt̊u, mazáńı soubor̊u, ř́ızeńı projekt̊u a kontrola stavu pro-
váděných praćı, přidělováńı práce jednotlivým zaměstnanc̊um a správa zaměstnanecké
agendy.

Bohužel při práci s t́ımto systémem jsem narážel na problém v hardwarové konfiguraci
dostupných stanic, které jsou již značně zastaralé a pro tento systém výkonově velmi pod-
dimenzované. Nepodařilo se mi tud́ıž uspokojivě sprovoznit VaultServer, který je náročný
na výpočetńı výkon a množstv́ı operačńı paměti. T́ım byl zároveň značně omezen prostor
pro testováńı tohoto systému.

3.2 Systém SmarTeam

3.2.1 Stručné představeńı vlastnost́ı

Během mé práce na tomto projektu se nám naskytla př́ıležitost vyzkoušet také tento
systém a po seznámeńı se s ńım bylo rozhodnuto, že ho na naše pracovǐstě zavedeme
také. Studenti tak budou mı́t možnost vyzkoušet dva odlǐsné systémy, řeš́ıćı stejnou prob-
lematiku, porovnat vlastnosti jednotlivých zp̊usob̊u řešeńı a jejich výhody a nevýhody.
Já ve svém výkladu upozorńım zejména na některé zásadńı odlǐsnosti, které významně
odlǐsuj́ı obě řešeńı, možnosti a zp̊usob použit́ı.

Tento systém nab́ıdla ústavu firma TG Numic CZ, a.s. zastupuj́ıćı v České republice
výrobce firmu Smart Solution Ltd. Firma TG Numic CZ, a.s. také dodává např. systémy
Autodesk a SolidWorks, se kterými SmarTeam umı́ spolupracovat. Prvńı d̊uležitou odlǐs-
nost́ı je, že je k dispozici pouze pro platformu MS Windows.

PDM systém řeš́ıćı většinu organizačńıch problémů vznikaj́ıćıch při týmové práci nad
jednotlivými projekty. Efektivnost jeho nasazeńı v konstrukčńıch kancelář́ıch vedla k
zobecněńı SmarTeamu na univerzálńı prostředek týmové správy dokument̊u a daľśıch
objekt̊u, umožňuj́ıćı integrovat informace obsažené současně v r̊uzných typech software:
kancelářskými baĺıky programů poč́ınaje, přes konstrukčńı software až po komplexńı pod-
nikové informačńı systémy, tj. informace vrcholového ř́ızeńı, vývoje obchodu, ř́ızen výroby,
ekonomické a účetńı.

Objekty a informace o nich jsou uspořádány hierarchicky do stromových struktur jed-
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notlivých typ̊u jako např́ıklad strom jednotlivých projekt̊u a podprojekt̊u, strom výrobk̊u a
jejich část́ı, strom zákazńık̊u, dodavatel̊u, použ́ıvaných materiál̊u, pracovńıch skupin a pra-
covńık̊u atd. a zejména strom dokument̊u vytvořených ve všech použ́ıvaných typech soft-
ware. Jednotlivé informace jsou mezi sebou provázány logickými vazbami umožňuj́ıćımi
rychle se pohybovat mezi souvisej́ıćımi objekty bez ohledu na to, v jakém software byly
vytvořeny. Př́ıstup k jednotlivým dokument̊um a informaćım je ř́ızen definovanými př́ıstu-
povými právy. Dokumenty mohou být:

• jen prohĺıženy s použit́ım prohĺıžeč̊u

• komentovány jednak poznámkami, jednak tzv.
”
readlining“ umožňuj́ıćı vložit ko-

mentář (text či obrázek) př́ımo do dokumentu na patřičné mı́sto aniž by se stal jeho
obsahem

• upravovány s použit́ım automatického spuštěńı př́ıslušné aplikace.

SmarTeam pracuje s nejrozš́ı̌reněǰśımi databázovými systémy4 a disponuje vývojovými
prostředky na několika úrovńıch, což jej při použit́ı ODBC ovladač̊u, OLE a DDE čińı
univerzálně použitelným k propojeńı nejr̊uzněǰśıch kombinaćı programového vybaveńı jed-
notlivých podnik̊u. Systém je doplněn ještě těmito moduly:

SmarTeam-Works – je prostředek správy dat pro SolidWorks obsahuj́ıćı dokument
management, prohĺıžeče MS Office a SolidWorks, integraci se SolidWorks.

SmartDesk – prostředek správy dat pro AutoCAD obsahuj́ıćı dokument manegement,
prohĺıžeče MS Office a AutoCAD, integraci se AutoCAD.

SmartView – obsahuje v současnosti přes 140 prohĺıžeč̊u nejrozš́ı̌reněǰśıch formát̊u doku-
ment̊u z oblasti office a CAD, umožňuje redlining vektorových formát̊u.

SmartWeb – umožňuje vzdálený př́ıstup do databáze SmarTeamu prostřednictv́ım inter-
netu nebo intranetu. To je jedna z velkých výhod, protože umožňuje źıskat informace
pouze pomoćı www prohĺıžeče bez instalace celého systému.

SmartFlow – kompletńı workflow – automatický tok dokument̊u v prostřed́ı SmarTeamu.

3.2.2 Instalace

1. Po vložeńı CD do mechaniky se bud’ spust́ı automaticky install.exe nebo ho
spust́ıme z kořenového adresáře ručně.

2. Zadáme jméno a firmu pro následnou registraci.

3. Zvoĺıme druh instalace a zadáme adresář pro instalaci.

4MS SQL, Oracle, Ingres, Informix, Interbase, DB2 . . .
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4. Vybereme komponenty, které chceme instalovat:

Standalone – Nainstaluje SmarTeam včetně databázového serveru InterBase.

Compact instalation – pro poč́ıtače s malým pevným diskem, nainstaluje
pouze nejd̊uležitěǰśı součásti

Typical instalation – doporučená pro většinu uživatel̊u, nainstaluje potřebné
součásti a populárńı komponenty použ́ıvané většinou uživatel̊u

Custom – umožńı vlastńı výběr součást́ı a komponent k instalaci

SmarTeam – hlavńı program nutný pro funkci

SmartTools – komponenty pro usnadněńı správy

Integration Plug-ins – moduly pro propojeńı se SolidWorks, Autocad,
Mechanical-Desktop, CADKEY, MS Office a daľśımi.

SmartView – program pro prohĺıžeńı r̊uzných CAD a Office dokument̊u,
pro které nemáme nainstalované extra programy

Solid Edge Viewer – modul pro prohĺıžeńı Solid Edge dokument̊u

SmartFlow Tools – modul pro správu workflow a grafický program pro
zadáváńı pracovńıch vztah̊u

Sample Files – ukázkové dokumenty pro výuku

Help Files – soubory nápovědy

Documentation – dokumentace ve formátu Adobe PDF

Demo DataBase and DemoFiles – vzorové projekty a ukázkové sou-
bory

Icons Library – databáze ikon a vzorových obrázk̊u

Client – Nainstaluje SmarTeam pro připojeńı ke vzdálenému databázovému serveru.

SmarTeam Client – Nainstaluje SmarTeam a použije databázi umı́stěnou na
serveru, pokračuje volbami shodnými se Standalone s těmito změnami:

Vault Tools – komponenty pro spojeńı s databázovým serverem

Remote Demo Database – jako Demo DataBase and DemoFiles,
ale spolupracuj́ıćı se serverem

SmartBox Client – Nainstaluje SmartBox a použije databázi na serveru

SmartView – program pro prohĺıžeńı r̊uzných CAD a Office dokument̊u,
pro které nemáme nainstalované extra programy

Solid Edge Viewer – modul pro prohĺıžeńı Solid Edge dokument̊u

SmartBox – obsahuje SmartFlow procesy a SmartTeam messages, použ́ı-
vá se k informováńı uživatel̊u o zadaných úkolech a úkolech dokončených
kolegy, na kterých má pokračovat

Help Files – soubory nápovědy

Documentation – dokumentace ve formátu Adobe PDF
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SmartFlow Tools – modul pro správu workflow a grafický program pro
zadáváńı pracovńıch vztah̊u

Demo – Nainstaluje SmarTeam včetně databázového serveru InterBase a vzorových
projekt̊u. Omezeńı této instalace spoč́ıvá v tom, že umožňuje pracovat maxi-
málně s 4000 prvky, tento počet je pro naše studijńı účely plně dostačuj́ıćı.

Integration Plug-ins – moduly pro propojeńı se SolidWorks, Autocad, Me-
chanical-Desktop, CADKEY, MS Office a daľśımi.

SmartView – program pro prohĺıžeńı r̊uzných CAD a Office dokument̊u, pro
které nemáme nainstalované extra programy

Solid Edge Viewer – modul pro prohĺıžeńı Solid Edge dokument̊u

SmartFlow Tools – modul pro správu workflow a grafický program pro za-
dáváńı pracovńıch vztah̊u

Refresh Demo – program pro obnoveńı výchoźıho stavu demostračńıch pro-
jekt̊u

5. Zkontrolujeme nastaveńı instalačńıho programu, k předchoźım nastaveńım se vždy
můžeme vrátit tlač́ıtkem Back, potom spust́ıme instalaci. Na disku potřebujeme,
podle vybraného typu instalace a množstv́ı komponent, 100MB až 400MB volného
mı́sta. Demo instalace zabere cca 300MB.

Po dokončeńı instalace a restartu operačńıho systému, můžeme spustit
hlavńı program touto ikonou z programové skupiny SmarTeam 3.1.

3.2.3 Popis funkćı programu

Po spuštěńı SmarTeamu se nám otevře okno, kde se nás systém ptá na uživatelské jméno
a heslo, po jejich zadáńı se připoj́ı k databázi a následně otevře hlavńı ovládaćı okno,
které je na obrázku 3.5, pomoćı něj máme př́ıstup ke všem hlavńım funkćım systému s
oprávněńımi př́ıslušej́ıćımi danému uživateli.

Jednotlivé ikony si poṕı̌seme v následuj́ıćım odstavci, k popisovaným funkćım se rovněž
můžeme dostat přes menu:

1. vytiskne obsah právě aktivńıho okna, File → Print – strukturu projektu, tabulku,
materiálovou kartu, náhled apod.

2. otevře okno pro nastaveńı tiskárny, File → Print Setup . . . – standardńı okno pro
nastaveńı velikosti a orientace paṕıru, použit́ı barev, atd.

3. smaže označený objekt a vlož́ı ho do schránky, Edit → Cut

4. okoṕıruje označený objekt do schránky, Edit → Copy

5. vlož́ı objekt ze schránky, Edit → Paste
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Obrázek 3.5: Hlavńı okno systému SmarTeam.

6. otevře okno pro zadáńı vyhledávaćıch kritéríı k vyhledáńı libovolného objektu,
Edit → Find Object – prohledává se celá databáze, vyhledávat můžeme podle
přednastavených kritéríı nebo si definovat svoje např. libovolný typ dokumentu,
položku v tabulce či na kartě, kritéria lze rovněž libovolně kombinovat

7. vyhledáváńı podle atributu objektu – př́ımý př́ıstup k upřesňuj́ıćımu nastaveńı
možný též přes tlač́ıtko 6.

8. vyhledáváńı objektu podle vzoru – př́ımý př́ıstup k upřesňuj́ıćımu nastaveńı možný
též přes tlač́ıtko 6.

9. vyhledáváńı textu, Edit → Find Text – vyhledá zadanou posloupnost znak̊u v
aktuálńım dokumentu

10. kontextová nápověda, Help → Contents nebo klávesa F1 – nápovědu můžete źıskat
zadáńım kĺıčového slova nebo výběrem ze seznamu, pomoćı menu Help můžete také
otevř́ıt učebnici nebo www stránky výrobce

11. seřazeńı otevřených oken do kaskády tak, že jsou vidět jejich jména, Window →
Cascade

12. seřazeńı otevřených oken pod sebe tak, že jsou vidět celá okna, Window → Tile
Horizontally

13. seřazeńı otevřených oken vedle sebe tak, že jsou vidět celá okna, Window → Tile
Vertically
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14. spust́ı komunikačńı program, SmartFlow → SmartBox – jedná se o program velmi
podobný poštovńımu klientovi, který však slouž́ı pro komunikaci se systémem. Pokud
např. přidáte do projektu daľśı objekt, systém automaticky zašle informaci ostatńım.
Pokud Váš kolega dokonč́ı součást, systém Vám zašle zprávu, že můžete pokračovat
např. v práci na navazuj́ıćı části. Vše je ř́ızeno dopředu navrženým schématem
toku práce5. Součást́ı každé zprávy jsou informace o č́ısle procesu, odeśılateli, datu
vytvořeńı, pracovńımu času a poklepáńım myš́ı si můžete přǐrazený dokument ihned
prohlédnout.

15. otevře okno všech projekt̊u v databázi, Browser → Projects – přehledně zobrazuje
veškeré informace o projektech: jméno, údaje o zakladateli, souvisej́ıćı dokumenty,
potřebné materiály, pod́ılej́ıćı se pracovńıky atd.

16. otevře okno všech dokument̊u př́ıslušej́ıćıch k projektu vybranému v okně projekt̊u,
Browser → Documents – zde máme pohromadě všechny dokumenty od text̊u až
po 3D modely. Samozřejmost́ı je př́ıstup k informaćım o materiálech, pracovńıćıch,
souvisej́ıćıch dokumentech, náhled do dokument̊u atd.

17. otevře okno materiálové rozpisky př́ıslušej́ıćıch k projektu vybranému v okně pro-
jekt̊u, Browser → Materials – jsou k dispozici informace o dodavateli, součásti, pro
kterou materiál potřebujeme, souvisej́ıćı dokumenty, pracovńıci, prohĺıžeč atd.

18. otevře okno všech položek, Browser → Items – zde máme pohromadě všechny
součásti výrobku, které sami nevyráb́ıme a zajǐst’ujeme je dodavatelsky, např. šrouby,
matice, podložky, rezistory, kondenzátory apod. samozřejmost́ı jsou informace o do-
davateĺıch, výkresy apod.

19. otevře okno kontakt̊u, Browser→ Contacts – zde máme přehledně seřazeny všechny
dodavatele (odběratele) a okamžitě k dispozici informace typu: kontaktńı osoba,
śıdlo firmy, telefon, fax, kromě všech běžných kontaktńıch údaj̊u hned vid́ıme dále:
projekty, na kterých se pod́ıĺı, souvisej́ıćı výkresy sestav i dodávaných d́ıl̊u a daľśı
souvisej́ıćı informace

20. definice práv uživatel̊u Browser → Users – toto je velmi d̊uležité okno, nebot’ zde
administrátor zadává práva pro jednotlivé pracovńıky: editace, vytvářeńı prohĺıžeńı.
A to jak přesně potřebuje na skupinu dokument̊u, jednotlivé dokumenty či projekty.
Samozřejmost́ı je definice hesla a osobńı údaje.

21. otočeńı o 180◦ – manipulace s náhledy výkres̊u

22. otočeńı o 90◦ – manipulace s náhledy výkres̊u

23. otáčeńı ve směru hodinových ručiček – manipulace s náhledy výkres̊u

24. zvětšeńı – manipulace s náhledy výkres̊u

5v originále WorkFlow
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25. zmenšeńı – manipulace s náhledy výkres̊u

26. velikost tak, aby součást vyplňovala okno – manipulace s náhledy výkres̊u

27. překresleńı – manipulace s náhledy výkres̊u

28. tisk zobrazovaného náhledu

29. nastaveńı prohĺıžeče

30. k dané sestavě zobraźı použité šrouby modelované v SolidWorks, View→ Run View
→ SW Bolts

31. k dané sestavě zobraźı použité hřeb́ıky modelované v SolidWorks, View→ Run View
→ SW Pins

32. k dané sestavě zobraźı použité součásti z plechu modelované v SolidWorks, View →
Run View → SW Plates

33. k dané sestavě zobraźı použité podložky modelované v SolidWorks, View → Run
View → SW Washers

34. k dané sestavě zobraźı ostatńı dokumenty, např texty, obrázky, html apod., View
→ Run View → SW Viewer – u této položky a předchoźıch čtyř samozřejmě zálež́ı
na tom do jaké skupiny jsme je zařadili

35. hlavńı okno projektu, př́ıpadně daľśı otevřená okna

36. infomace o uživateli, který je právě přihlášen

37. stavový řádek, kde se zobrazuje nápověda podle polohy kurzoru myši

Zřejmě jste si všimli, že zejména v bodech 15 až 20 jsem se často opakoval v popisu
informaćı, které můžeme nalézt v jednotlivých oknech. Každá informace je v systému
samozřejmě jen jednou, rozd́ıl spoč́ıvá v d̊uvodech, pro které se tyto informace zobrazuj́ı.
Každý uživatel má jinou práci, takže se na prezentované informace d́ıvá z jiného hlediska,
uved’me si př́ıklad:

• pracovńık obchodńıho odděleńı si otevře okno projekt̊u a má okamžitě přehled o
postupu praćı

• pracovńık plánovaćıho odděleńı si otevře okno uživatel̊u, vid́ı v podstatě tytéž in-
formace pouze jinak prezentované a má okamžitě přehled o vyt́ıžeńı jednotlivých
pracovńık̊u třeba v konstrukci.
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Obrázek 3.6: Administrátorské nástroje systému SmarTeam

Dále je potřeba podotknout, že popisované ikony jsou základńım nastaveńım systému,
jejich funkce, rozmı́stěńı a množstv́ı je možné libovolně upravit podle přáńı uživatele.

Ned́ılnou součást́ı systému je sada administrátorských nástroj̊u pro kompletńı nas-
taveńı systému, na obrázku 3.6 je zobrazena sada spouštěćıch ikon. Některé nástroje je
možno rovněž spouštět z menu Tools programu SmarTeam.

Jedńım z nejd̊uležitěǰśıch nástroj̊u v této skupině je Flow Chart Designer, který je
určen k definováńı vazeb mezi uživateli. Při pohledu na jeho hlavńı okno, které je na
obrázku 3.7, již můžeme vytušit zp̊usob použit́ı. Pomoćı ikon, které jsou vpravo můžeme

Obrázek 3.7: Program Flow Chart Designer systému SmarTeam

přidávat jednotlivé uživatele a vazby mezi nimi. Kliknut́ım pravým tlač́ıtkem myši na
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vazbě nebo uživateli nastavujeme konkrétńı hodnoty parametr̊u a určujeme, který pra-
covńık vykoná danou činnost. Veškerá práce je velmi intuitivńı a neměla by zaškolené
obsluze činit pot́ıže.

Na obrázku vid́ıme jednoduchý př́ıklad použit́ı. Vlevo máme výchoźı uzel, většinou
ukončeńı předchoźı činnosti, z něj vycházej́ı tři paralelńı větve ke třem pracovńık̊um,
kteř́ı prováděj́ı zadaný úkol současně, po dokončeńı své činnosti každý pracovńık předá
sv̊uj výsledek k autorizaci, kde daľśı pracovńık (nebo systém) čeká na výsledky všech tř́ı
pracovńık̊u, když je dostane, tak odešle celkový výsledek dále. Z grafu je tedy na prvńı
pohled patrné, kteř́ı pracovńıci jsou na sobě závisĺı, a kteř́ı mohou pracovat nezávisle na
ostatńıch.

Z daľśıch administrátorských nástroj̊u ještě zd̊urazńım následuj́ıćı:

Form Designer – program pro vytvářeńı vlastńıch formulář̊u, jeho ovládáńı je rovněž
velmi snadné, uživatel si tak může navrhnout vlastńı formuláře pro veškeré doku-
menty v systému podle vlastńı potřeby.

SmartFlow Manager – program pro sledováńı systému. Vytvář́ı statistiky plněńı plánu,
umožňuje vyhledávat konkrétńı procesy, sledovat SmartBoxy jednotlivých uživatel̊u
atd.

Smart Wizard – kouzelńık, který uživatele provede celým návrhem struktury projektu,
což velmi usnadňuje práci, nicméně uživatel má možnost do procesu zasahovat a
upravovat tak výsledek podle své potřeby.

Users Maintenance – ovládáńı př́ıstupových práv jednotlivých uživatel̊u, jejich přǐra-
zováńı do skupin, povolováńı př́ıstupu k dokument̊um, editaci nebo pouze prohĺıžeńı
apod.

Ještě je d̊uležité zmı́nit, že ke každému oknu a konkrétńı položce je k dispozici kontex-
tové menu s relevantńımi př́ıkazy. Toto menu zobraźıme stisknut́ım pravého tlač́ıtka myši
s kurzorem na požadované položce.

Popis programu zde ukonč́ı, nebot’ to je téma na samostatnou diplomovou práci a
neńı to zde účelem. Účelem bylo nast́ınit vám komplexnost systému a jeho možnosti. To,
zda firma plně využije jeho možnost́ı záviśı do značné mı́ry na administrátorovi systému,
nebot’ popisované prostřed́ı je velmi modulárńı a zálež́ı na něm, zda z něj dokáže vytěžit
maximum pro danou firmu.

Pod pojmem administrátor samozřejmě nemysĺım jednoho člověka, ale tým odborńık̊u
jednak ze strany dodavatele systému a jednak ze strany firmy. Zde je velmi d̊uležité, aby
si odběratel ve spolupráci s dodavatelem předem ujasnil, co vlastně od tohoto systému
očekává a jaké jsou jeho požadavky. Výsledky je vhodné ztvárnit ve formě dokumentu,
který obě strany podeṕı̌śı na d̊ukaz souhlasu a na př́ıpadných změnách se muśı rovněž
dohodnout.



Kapitola 4

Světový trend stylu ř́ızeńı podnikové
výroby

Východiska tohoto projektu jsme si již vysvětlili v kapitole 2. Zopakujme si nyńı nejd̊ule-
žitěǰśı aspekty vývoje trh̊u a s nimi spojené změny v ř́ızeńı podnik̊u.

• Trhy se d́ıky deregulaćım velmi rychle měńı, poptávka se také měńı a je náročněǰśı.
Váš produkt tedy muśı být vyvinut rychleji, je komplexněǰśı a použité procesy jsou
rovněž komplexněǰśı. Nutná podmı́nka tedy zńı:

”
muśıte co nejekonomičtěji využ́ıt

čas, který máte k dispozici“.

• Docháźı ke globálńımu r̊ustu konkurence, takže abyste uspokojili v́ıce zákazńık̊u,
zač́ıná se přecházet k malosériové výrobě s velkým počtem mutaćı základńıho vý-
robku. To se projevuje zejména zvýšeným tlakem na složky TPV – rychleji, levněji
kvalitněji.

• Daľśım faktorem je stále rychleǰśı rozmach vědeckotechnických poznatk̊u. Je nutné
zač́ıt s TPV co nejpozději, abychom měli k dispozici nejnověǰśı technologie a zároveň
co nejdř́ıve, abychom měli dostatek času na př́ıpravu. Pokud začneme později máme
také již naakumulován kapitál z prodeje předchoźıho výrobku.

Zkráceńı této doby se projevuje jednak v rychlosti TPV realizovat myšlenku od nápadu
až po výrobu a také ve zp̊usobu a schopnostech reagovat na změny během TPV, at’ již
vzniklé chybou, vylepšeńım či jiným zp̊usobem.

Chtěj́ı-li firmy z̊ustat konkurenceschopné, pak muśı reagovat a zcela provést transfor-
maci své pr̊umyslové výroby. Za posledńıch 20 let došlo ve světě k výrazným změnám, na
které naše země muśı nutně reagovat. Velké a prosperuj́ıćı světové firmy jako např́ıklad
General Motors či Ford již několik let pracuj́ı na zaváděńı PDM do své informačńı struk-
tury, aby maximálně zlevnili a urychlili výrobu při zachováńı vysoké kvality. Tyto firmy
maj́ı samozřejmě mnohem v́ıce zkušenost́ı z konkurenčńıho prostřed́ı a přesto zavedeńı
PDM pro ně neńı jednoduchým krokem a potřebuj́ı na něj několik let.
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1980 1990 2000

Ćıl organizace Zisk Pod́ıl na trhu Nové trhy

Strategie Zisk
”
Včas na trhu“ Inovace

Technologický aspekt Rychlost Optimálńı využit́ı Využit́ı

informaćı
”
intelektuálńıho

kapitálu“

Systém pro podporu Jednotlivý CAD CAD/CAM – CAD/CAM –

výroby počátky EPD EPD, PDM!

Výrobńı proces Sériový proces Paralelńı proces Velké kooperace

Organizačńı hledisko Odděleńı Projekčńı týmy Flexibilńı/virtuálńı

týmy!

Tabulka 4.1: Vývoj organizace podnik̊u

V naš́ı zemi je situace taková, že organizace se pohybuj́ı někde na úrovni roku 1980,
v lepš́ım př́ıpadě 1990. Maj́ı-li obstát v konkurenci, je potřeba zachytit dynamický pro-
ces 2000, předevš́ım zavést organizaci typu:

”
flexibilńı/virtuálńı týmy“. Zde nejsou tak

velké firmy a máme méně zkušenost́ı, nicméně zavedeńı PDM do menš́ıho podniku neńı
tak složité, protože tyto firmy maj́ı obvykle jednodušš́ı organizačńı strukturu a méně in-
formaćı. Firmy, které se u nás zač́ınaj́ı prosazovat, tak maj́ı jedinečnou př́ıležitost zavést
PDM v počátćıch své kariéry a již od začátku použ́ıvat tuto vysoce progresivńı technologii,
která jim mimo jiné může např́ıklad podstatně zjednodušit certifikaci ISO 9000, která
vyžaduje propracovaný informačńı systém. Ćılem tohoto projektu je podpořit snahu o
vytvořeńı pracovǐstě, které by simulovalo tento proces pomoćı technologie PDM a zároveň
pracovalo s CAD systémy.



Závěr

Úkolem mé práce bylo:
”
Zavedeńı technologie PDM pro zvolený typ organizace“. Ve své

práci jsem nikde konkrétně neuvedl pro jakou organizaci systém navrhuji, to má sv̊uj
d̊uvod v tom, že popisované systémy maj́ı velmi široké možnosti uplatněńı, nicméně typ-
ickým př́ıkladem organizace, která může využ́ıvat takový systém je klasický výrobńı pod-
nik s vlastńım vývojem a konstrukćı. Student, který absolvuje na našem pracovǐsti výše
zmı́něné kurzy, bude mı́t proti svým koleg̊um značnou výhodu, zat́ımco jeho kolegové
se budou muset v praxi za velmi vysoké ceny učit vše od začátku, náš absolvent se již
seznámı́ pouze s konkrétńım ovládáńım použitého programu a může zač́ıt ihned pracovat.

Za přispěńı mé práce a dlouhodobé činnosti koleg̊u na pracovǐsti, tedy bude na podzim
výsledkem otevřeńı kurzu CDM. Nyńı je plněn prvńı krok a to zavedeńı klient̊u systému
Optegra na pracovǐstě CAD-D, na podzim by ještě mělo doj́ıt k nákupu výkonněǰśıch
stanic, na kterých by se dal instalovat rovněž VaultServer.

Hardwarovou konfiguraci nových stanic jsem konzultoval s vývojáři firmy JULI MO-
TORENWERK, k.s., kteř́ı se zabývaj́ı vývojem pohon̊u do vysokozdvižných voźık̊u. Oni
v současné době použ́ıvaj́ı stanice osazené iPII/450MHz, RAM 256MB, HDD 4GB a 21”
monitory. Tyto stanice jsou však dnes již na výkonové hranici, proto doporučuji nakoupit
stanice s procesory alespoň iPIII/850MHz i z hlediska ochrany investic, aby nově koupené
stanice nebyli už vlastně zastaralé. Nákup monitor̊u je pak již otázkou možnosti investo-
vat, kde plat́ı:

”
č́ım větš́ı, t́ım lepš́ı“, záruku kvality při tom skýtaj́ı značky SONY a EIZO.

Při použ́ıváńı systému CADDS5 lze rovněž uvažovat o koupi stanic SGI, odpov́ıdaj́ıćı řada
je O2 s procesory R12000. Pro tyto stanice hovoř́ı zejména lepš́ı podpora výrobce systému
CADDS5.

Systém SmarTeam bude vyučován v učebně CAD-C na pěti PC společně s 3D CAD
systémem SolidWorks. Přes prázdniny by rovněž měl být začleněn do kurzu Grafické
systémy, kde bude představen také společně s AutoCADem. Možnosti tohoto systému
jsou na současném pracovǐsti širš́ı zejména s ohledem na hardware, protože neńı tak
náročný na výpočetńı výkon. Dále obsahuje př́ımou podporu výše zmı́něných systémů a
pro

”
Windows-uživatele“ je snažš́ı se ho naučit ovládat.

Výuka může prob́ıhat např́ıklad tak, že skupina student̊u dostane zadáńı, např́ıklad
výkresovou dokumentaci sṕınače, jističe, zásuvky a pod. Dokumentace bude obsahovat
chyby, které studenti naleznou během práce a pomoćı komunikace v PDM budou provádět
změnová ř́ızeńı a využ́ıvat při tom funkce systému, aby si procvičili a pochopili princip.
Během práce jim zaroveň mohou být hlášeny změny materiál̊u pro některé součásti a pod.
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Doufám, že tato práce přispěje ke zkvalitněńı a rozš́ı̌reńı výuky velkých CADů na
UETE, nebot’ se jedná o technologii budoucnosti a studenti, kteř́ı absolvuj́ı př́ıslušné
kurzy spolu s prax́ı budou špičkovými odborńıky v oboru konstrukce.



Slovńıček pojmů a zkratek

CA . . . – Computer Aided . . . – t́ımto chci zd̊uraznit, že to co zde prezentuji pod označeńım
CAD už nemuśı být jen náhrada kresĺıćıho prkna, nýbrž komplexńı systém pro návrh
výrobku

CAD – Computer Aided Design

CAM – Computer Aided Manufacturing

DDE – Dynamic Data Exchange

entita – jednoduchý, plně určený objekt, ze kterého skládáme naši součást (kružnice,
úsečka, apod.)

EPD – Electronic Product Definition

NURBS – systém definováńı ploch

ODBC – Open Database Connectivity

OLE – Object Link Exchange

PDM – Product Data Management

solid modeling – objemové modelováńı

surface modeling – povrchové modelováńı

TPV – Technická Př́ıprava Výroby

UETE – Ústav elektrotechnologie

uzel – jednoznačně určené mı́sto na entitě (u př́ımky jej́ı konec, ale také např. polovina,
u kružnice např. jej́ı střed)
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Abstract

This work deal with implementation support design and above all administration factory
data on workplace, which serve as model of real factory. Have for one’s object educate
students designers, who they are partly able work with 3D CAD system and also organize
all information about product in order to be available always and anywhere.

Current workplace will be enriched about PDM system Optegra and SmarTeam, rele-
vant course graduate come into practice already fit and even possible segue other software
would not have him any demur to resolve the same problems.
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